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8. Mentor Graphics PCB Design Tools
Support
Introduction
With today’s large, high-pin-count and high-speed FPGA devices, good and correct 
printed circuit board (PCB) design practices are more essential than ever for ensuring 
correct system operation. Typically, the PCB design takes place concurrently with the 
design and programming of the FPGA. Signal and pin assignments are initially made 
by the FPGA or ASIC designer, and the board designer must correctly transfer these 
assignments to the symbols used in their system circuit schematics and board layout. 
As the board design progresses, pin reassignments may be needed to optimize the 
PCB layout. These reassignments must in turn be relayed back to the FPGA designer 
so that the new assignments can be processed through an updated placement and 
routing of the FPGA design.

Mentor Graphics® provides tools to support this type of design flow. This chapter 
discusses how the Quartus® II software interacts with the Mentor Graphics 
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FPGA-to-PCB Design Flow
In the examples in this section, you create a design flow integrating an Altera® FPGA 
design from the Quartus II software, and a circuit schematic in the DxDesigner 
software. Figure 8–1 shows the design flow with and without the I/O Designer 
software.

Figure 8–1. Design Flow with and without the I/O Designer Software

Note to Figure 8–1:

(1) The Quartus II software generates the FPGA Xchange file in the output directory you specify in the Board-Level Assignment Settings. However, 
the Quartus II software and the I/O Designer software can import pin assignments from an FPGA Xchange file located in any directory. Altera 
recommends that you work with a backup of the FPGA Xchange file to prevent overwriting existing assignments or importing invalid assignments.
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The following tasks, which are described in this chapter, describe how to proceed 
through the design flow shown in Figure 8–1:

■ Set up the board-level assignment settings to generate an FPGA Xchange file (.fx) 
for symbol generation in the Quartus II software

■ Compile the design and generate the FPGA Xchange file and the Pin-Out file 
(.pin), which are located in the Quartus II project directory

■ Create a board design using the DxDesigner software together with the 
I/O Designer software, which involves the following steps:

■ Create a new I/O Designer database based on the FPGA Xchange file and the 
Pin-Out file

■ Make adjustments to signal and pin assignments in the I/O Designer software

■ Regenerate the FPGA Xchange file in the I/O Designer software to reflect the 
I/O Designer software changes in the Quartus II software

■ Generate a single or fractured symbol for use in the DxDesigner software 

■ Add the symbol to the sym directory of a DxDesigner project, or specify a new 
DxDesigner project with the new symbol

■ Instantiate the symbol in your DxDesigner schematic and export the design to 
the board layout tool

■ Back-annotate pin changes created in the board layout tool to the DxDesigner 
software and back to the I/O Designer software and the Quartus II software

■ Create a board design using the DxDesigner software without the I/O Designer 
software, which involves the following steps:

■ Create a new DxBoardLink symbol using the Symbol Wizard and reference the 
Pin-Out file output from the Quartus II software in an existing DxDesigner 
project

■ Instantiate the symbol in your DxDesigner schematic and pass the design to a 
board layout tool

The I/O Designer software allows you to take advantage of the full FPGA symbol 
design, creation, editing, and back-annotation flow supported by Mentor Graphics 
tools.

1 Symbols can be updated with design changes at any point with or without the 
I/O Designer software. However, if symbols are changed in the DxDesigner software, 
the I/O Designer software does not see the changes. If you change symbols using the 
DxDesigner software, you must reimport the symbols into I/O Designer to avoid 
overwriting your symbol changes.
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Setting Up the Quartus II Software
You can transfer pin and signal assignments from the Quartus II software to the 
Mentor Graphics tools by generating two output files, a Pin-Out file (.pin) and an 
FPGA Xchange file (.fx) (Figure 8–2). 

The two output files, the Pin-Out file and the FPGA Xchange file, are described in 
Table 8–1.

Figure 8–2. Pin-Out Files and FPGA Xchange Files (Note 1)

Note to Figure 8–2:

(1) Refer to Figure 8–1 for the full design flow, which includes the I/O Designer software, the DxDesigner software, and 
the board layout tool flowchart details.
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Table 8–1. Pin Assignment Output File Format Comparison

File Format Description

Pin-Out file (.pin) 
(1)

An output file generated by the Quartus II Fitter. The file cannot be imported into the Quartus II 
software to change pin assignments. The file contains a complete list of the device pins including any 
unused I/O pins, and provides the following basic information fields for each assigned pin on a device:

■ Pin signal name/usage

■ Pin number

■ Signal direction

■ I/O standard

■ Voltage

■ I/O Bank

■ User or Fitter assigned

FPGA Xchange file 
(.fx) (1),(2)

An input/output file generated by the Quartus II software and the I/O Designer software that can be 
imported and exported from both programs. Industry standard with room for future changes and 
additions. The FPGA Xchange file generated by the Quartus II software lists only assigned pins. The file 
provides the following advanced information fields for each pin on a device:

■ Pin number

■ I/O Bank

■ Signal name

■ Signal direction

■ I/O standard

■ Drive strength (mA)

■ Termination enabling

■ Slew rate

■ IOB Delay

■ Swap group

■ Differential pair type

When generated by the I/O Designer software, all pins, including unused pins, are listed and the 
following fields are added:

■ Swap group

■ Differential pair type

■ Device pin name

■ Pin set

■ Pin set position

■ Pin set group

■ Super pin set group

■ Super pin set position

Notes to Table 8–1:

(1) For additional information about these file formats, refer to the Quartus II Help.
(2) For additional information about the information fields added by the Mentor Graphics software, refer to the Mentor Graphics website at 

www.mentor.com.
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The I/O Designer software can also read from or update a Quartus II Settings File 
(.qsf). The Quartus II Settings File is used in the design flow in a similar manner to the 
FPGA Xchange file, but does not transfer pin swap group information between the 
I/O Designer software and the Quartus II software.

1 The Quartus II Settings File also contains additional important information about 
your project that is not used by the I/O Designer software. Because of this, Altera 
recommends that you use the FPGA Xchange file instead of the Quartus II Settings 
File for this design flow.

f For more information about the Quartus II Settings File, refer to the Quartus II Settings 
File Reference Manual.

Generating Pin-Out Files
The Quartus II Fitter generates the Pin-Out file whenever you perform a full 
compilation or I/O Assignment Analysis on your design. The file is generated and 
placed in your design directory and your file is named <project name>.pin. The 
Mentor Graphics tools do not alter this file. The Quartus II software cannot import 
assignments from an existing Pin-Out file.

Generating FPGA Xchange Files
The FPGA Xchange file is not created automatically. To set up the Quartus II software 
to create the FPGA Xchange file, follow these steps:

1. Start the Quartus II software. On the Assignments menu, click Settings. The 
Settings dialog box appears.

2. Under EDA Tool Settings, click Board-Level. In the Board-Level Symbol Format 
list, choose FPGA Xchange.

3. Set the Output directory to the location where you want to save the file. The 
default output file path is <project directory>/symbols/fpgaxchange. Click OK.

4. On the Processing menu, point to Start and click Start EDA Netlist Writer.

The output directory you selected is created when you generate the FPGA Xchange 
file.

c Both the Quartus II software and the I/O Designer software can export and import an 
FPGA Xchange file. It is therefore possible to overwrite the FPGA Xchange file and 
import incorrect assignments into one or both programs. To prevent this occurrence 
from happening, make a backup copy of the file before importing, and import the 
copy instead of the file generated by the Quartus II software. In addition, assignments 
in the Quartus II software can be protected by following the steps in “Protecting 
Assignments in the Quartus II Software” on page 8–18.

Creating a Backup Quartus II Settings File
To create a backup Quartus II Settings File, perform the following steps:

1. On the Assignments menu, click Import Assignments. The Import Assignments 
dialog box appears.
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2. In the Import Assignments dialog box, browse to your project and turn on Copy 
existing assignments into <project name>.qsf.bak.

3. Click OK.

Following these steps automatically creates a backup Quartus II Settings File of your 
current pin assignments.

f For more information about pin and signal assignment transfer, and files the 
Quartus II software can import and export, refer to the I/O Management chapter in 
volume 2 of the Quartus II Handbook.

FPGA-to-Board Integration with the I/O Designer Software
The Mentor Graphics I/O Designer software allows you to integrate your FPGA and 
PCB designs. Pin and signal assignment changes can be made anywhere in the design 
flow, typically using either the Quartus II Pin Planner or the I/O Designer software. 
The I/O Designer software facilitates moving these changes, as well as synthesis, 
placement, and routing changes, between the Quartus II software, an external 
synthesis tool (if used), and a schematic capture tool such as the DxDesigner software.

This section describes how to use the I/O Designer software to transfer pin and signal 
assignment information to and from the Quartus II software with the FPGA Xchange 
file, and how to create symbols for the DxDesigner software.

Figure 8–3 shows the design flow using the I/O Designer software.
© March 2009 Altera Corporation Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization
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f For more information about the I/O Designer software, and to obtain usage, support, 
and product updates, use the Help menu in the I/O Designer software or refer to the 
Mentor Graphics website at www.mentor.com.

Figure 8–3. Design Flow Using the I/O Designer Software (Note 1)

Notes to Figure 8–3:

(1) Refer to Figure 8–1 for the full design flow including the Quartus II software flowchart details.
(2) These are DxDesigner software-specific steps in the design flow and are not part of the I/O Designer flow.
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I/O Designer Database Wizard
All I/O Designer project information is stored in an I/O Designer Database (.fpc) file. 
You can create a new database that incorporates the FPGA Xchange file and Pin-Out 
file information generated by the Quartus II software by using the I/O Designer 
Database Wizard. You can also create a new, empty database and manually add the 
assignment information. If there is no signal or pin assignment information currently 
available, you can create an empty database that contains only a selection of the target 
device. This is useful if you know the signals in your design and the pins you want to 
assign. You can transfer this information at a later time to the Quartus II software for 
place-and-route.

It is possible to create an I/O Designer database with only one type of file or the other. 
However, if only a Pin-Out file is used, any I/O assignment changes made in the 
I/O Designer software cannot be imported back into the Quartus II software without 
first generating an FPGA Xchange file. If only an FPGA Xchange file is used to create 
the I/O Designer database, the database may not contain a complete picture of all of 
the I/O assignment information available. The FPGA Xchange file generated by the 
Quartus II software only lists pins with assigned signals. Since the Pin-Out file lists all 
device pins—whether signals are assigned to them or not—its use, along with the 
FPGA Xchange file, produces the most complete set of information for creating the 
I/O Designer Database.

To create a new I/O Designer database using the Database Wizard, perform the 
following steps:

1 If you skip a step in this process, you can complete the skipped step later, filling in the 
appropriate information. To return to a skipped step, on the Properties menu, click 
File.

1. Start the I/O Designer software. The Welcome to I/O Designer dialog box 
appears. Select Wizard to create new database and click OK.

1 If the Welcome to I/O Designer dialog box is not shown because it was 
disabled, you can access the Wizard through the menus. To access the 
Wizard, on the File menu, click Database Wizard.

2. Click Next. The Define HDL source file page opens (Figure 8–4).
© March 2009 Altera Corporation Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization
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f For more information about creating and using HDL files in the Quartus II software, 
refer to the Recommended HDL Coding Styles chapter in volume 1 of the Quartus II 
Handbook, or refer to the I/O Designer Help.

1 If no HDL files are available, or if your signal and pin assignments are 
already contained in the FPGA Xchange file, you do not have to complete 
step 3 and can proceed to step 4.

3. If you have created a Verilog HDL or VHDL file in your Quartus II software 
design, you can enter a top-level Verilog HDL or VHDL file. Adding a file allows 
you to create functional blocks or get signal names from your design. All physical 
pin assignments must be created in I/O Designer if no FPGA Xchange file or 
Pin-Out file is used. Click Next. The Database Name page is shown.

4. In the Database Name window, enter your database file name. Click Next. The 
Database Location window is shown.

5. Enter a path to the new database or an existing one in the Location field, or browse 
to a database location. Click Next. The FPGA flow page is shown.

6. In the Vendor menu, click Altera. 

7. In the Tool/Library menu, click Quartus II 5.0, or a later version of the Quartus II 
software. 

8. Select the appropriate device family, device, package, and speed (if applicable), 
from the corresponding menus. Click Next. The Place and route page is shown.

Figure 8–4. Database Wizard HDL File Page
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1 The Quartus II software version selections in the Tool/Library menu may 
not reflect the version of the Quartus II software currently installed on your 
system even if you are using the most current version of the I/O Designer 
software. The version number selection in this window is used in the 
I/O Designer software to identify the devices that were available or 
obsolete in that particular version of the Quartus II software. If you are 
unsure of the version to select, use the most recent version listed in the 
menu. If the device you are targeting does not appear in the device menu 
after making this selection, the device may be new and not yet added to the 
I/O Designer software. For I/O Designer software updates, contact Mentor 
Graphics or refer to their website at www.mentor.com.

9. In the FPGAX file name field, type or browse to the backup copy of the FPGA 
Xchange file generated by the Quartus II software.

10. In the Pin report file name field, type or browse to the Pin-Out file generated by 
the Quartus II software. Click Next.

In addition, you can select a Quartus II Settings File for update. The I/O Designer 
software can update the pin assignment information in the Quartus II Settings File 
without affecting any other information contained in the file.

1 You can select a Pin-Out file without selecting an FPGA Xchange file for 
import. The I/O Designer software does not generate a Pin-Out file. To 
transfer assignment information to the Quartus II software, select an 
additional file and file type. Altera recommends selecting an FPGA 
Xchange file in addition to a Pin-Out file for transferring all of the 
assignment information contained within both types of files.

1 In some versions of the I/O Designer software, the standard file picker may 
incorrectly look for a Pin-Out file instead of an FPGA Xchange file. In this 
case, select All Files (*.*) from the Save as type list and select the file from 
the list.

11. The Synthesis page displays. On the Synthesis page, you can specify an external 
synthesis tool and a synthesis constraints file for use with the tool. If you do not 
use an external synthesis tool, click Next.

f For more information about third-party synthesis tools, refer to Volume 3: 
Verification of the Quartus II Handbook.

12. On the PCB Flow page, you can select an existing schematic project or create a 
new project as a destination for symbol information.

■ To select an existing project, select Choose existing project and click Browse 
after the Project Path field. The Select project dialog box appears. Select the 
project.

■ To create a new project, in the Select project dialog box, select Create new 
empty project. Enter the project file name in the Name field and browse to the 
location where you want to save the file (Figure 8–5). Click OK.
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If you have not specified a design tool to which you can send symbol information in 
I/O Designer, click Advanced in the PCB Flow page and select your design tool. If the 
DxDesigner software is selected, you have the option of specifying a Hierarchical 
Occurrence Attributes (.oat) file to import into the I/O Designer software. Click Next, 
then click Finish to create the database.

1 In I/O Designer version 2005 or later, the Update Wizard (refer to Figure 8–9 on 
page 8–16) is shown when you finish creating the database using the database wizard. 
Use the Update Wizard to confirm creation of the I/O Designer database using the 
selected FPGA Xchange and Pin-Out files.

Use the I/O Designer software and your newly created database to make pin 
assignment changes, create pin swap groups, or adjust signal and pin properties in the 
I/O Designer GUI (Figure 8–6).

Figure 8–5. Select Project Dialog Box
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f For more information about using the I/O Designer software and the DxDesigner 
software, refer to the Mentor Graphics website at www.mentor.com or refer to the 
I/O Designer software or the DxDesigner Help.

Updating Pin Assignments from the Quartus II Software
As the design process continues, the FPGA designer may need to make changes to the 
logic design in the Quartus II software that place signals on different pins after the 
design is recompiled, or manually by using the Quartus II Pin Planner. These types of 
changes must be carried forward to the circuit schematic and board layout tools to 
ensure that signals are connected to the correct pins on the FPGA. Updating the FPGA 
Xchange file and the Pin-Out file in the Quartus II software facilitates this flow 
(Figure 8–7).

Figure 8–6. I/O Designer Main Window
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To update the FPGA Xchange file and the Pin-Out file in the Quartus II software after 
making changes to the design, run a full compilation, or on the Start menu, point to 
Processing and click Start EDA Netlist Writer. The FPGA Xchange file in your 
selected output directory and the Pin-Out file in your project directory are updated. 
You must rerun the I/O Assignment Analyzer whenever you make I/O changes in 
the Quartus II software. To rerun the I/O Assignment Analyzer, on the Processing 
menu, click Start Compilation, or to run a full compilation, on the Processing menu, 
point to Start and click Start I/O Assignment Analysis.

f Refer to the I/O Management chapter in volume 2 of the Quartus II Handbook for more 
information about setting up the FPGA Xchange file and running the I/O Assignment 
Analyzer.

c If your I/O Designer database points to the FPGA Xchange file generated by the 
Quartus II software instead of a backup copy of the file, updating the file in the 
Quartus II software overwrites any changes made to the file by the I/O Designer 
software. If there are I/O Designer assignments in the FPGA Xchange file that you 
want to preserve, create a backup copy of the file before updating it in the Quartus II 
software, and verify that your I/O Designer database points to the backup copy. To 
point to the backup copy, perform the steps in the following section.

Whenever the FPGA Xchange file or the Pin-Out file is updated in the Quartus II 
software, the changes can be imported into the I/O Designer database. You must set 
up the locations for the files in the I/O Designer software.

1. To set up the file locations if they are not already set, on the File menu, click 
Properties. The project Properties dialog box appears (Figure 8–8).

Figure 8–7. Updating the I/O Designer Pin Assignments in the Design Flow (Note 1)

Note to Figure 8–7:

(1) Refer to Figure 8–1 for the full design flow, which includes the Quartus II software, the DxDesigner software, and the 
board layout tool flowchart details.
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2. Under FPGA Xchange, click Browse to select the FPGA Xchange file name and file 
location.

3. To specify a Pin report file, under Place and Route, click Browse to select the 
Pin-Out file name and file location.

After you have set up these file locations, the I/O Designer software monitors these 
files for changes. If the FPGA Xchange file or Pin-Out file changes during the design 
flow, three indicators flash red in the lower right-hand corner of the I/O Designer 
main window (see Figure 8–6 on page 8–13). You can continue working or click on the 
indicators to open the I/O Designer Update Wizard. If you have made changes to 
your design in the Quartus II software that result in an updated FPGA Xchange file or 
Pin-Out file and the update indicators do not flash or you have previously canceled 
an indicated update, manually open the Update Wizard. To open the Wizard, on the 
File menu, click Update.

1 In versions of the I/O Designer software before version 2005, instead of using flashing 
indicators, the I/O Designer software displays a dialog box asking if you want to 
open the Update Wizard.

The I/O Designer Update Wizard lists the updated files associated with the database 
(Figure 8–9).

Figure 8–8. Project Properties Dialog Box
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The paths to the updated files have yellow exclamation points and the Status column 
shows Not updated, indicating that the database has not yet been updated with the 
newer information contained in the files. A checkmark to the left of any updated file 
indicates that the file will update the database. Turn on any files you want to use to 
update the I/O Designer database, and click Next. If you are not satisfied with the 
database update, on the Edit menu, click Undo.

1 You can update the I/O Designer database using both the FPGA Xchange file and the 
Pin-Out file at the same time. Turning on both the FPGA Xchange file and the Pin-Out 
file for update causes the Update Wizard to provide options for using assignments 
from one file or the other exclusively or merging the assignments contained in both 
files into the I/O Designer database. Versions of the I/O Designer software older than 
version 2005 simply merge assignments contained in multiple files.

Sending Pin Assignment Changes to the Quartus II Software
In the same way that the FPGA designer can make adjustments that affect the PCB 
design, the board designer can make changes to optimize signal routing and layout 
that must be applied to the FPGA. The FPGA designer can take these required 
changes back into the Quartus II software to refit the logic to match the adjustments to 
the pinout. The I/O Designer software can accommodate this reverse flow as shown 
in Figure 8–10.

Figure 8–9. Update Wizard Dialog Box
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Pin assignment changes are made directly in the I/O Designer software, or the 
software automatically updates changes made in a board layout tool that are 
back-annotated to a schematic entry program such as the DxDesigner software. You 
must update the FPGA Xchange file to reflect these updates in the Quartus II 
software. To perform this update in the I/O Designer software, on the Generate menu, 
click FPGA Xchange File.

c If your I/O Designer database points to the FPGA Xchange file generated by the 
Quartus II software instead of a backup copy, updating the file from the I/O Designer 
software overwrites any changes that may have been made to the file by the 
Quartus II software. If there are assignments from the Quartus II software in the file 
that you want to preserve, make a backup copy of the file before updating it in the 
I/O Designer software, and verify that your I/O Designer database points to the 
backup copy. To point to the backup copy, perform the steps in “Updating Pin 
Assignments from the Quartus II Software” on page 8–13.

After the FPGA Xchange file is updated, you must import it into the Quartus II 
software. To import the file, perform the following steps:

1. Start the Quartus II software and open your project.

2. On the Assignments menu, click Import Assignments.

3. In the File name box, click Browse and from the Files of type list, select FPGA 
Xchange Files (*.fx).

4. Select the FPGA Xchange file and click Open.

5. Click OK.

Figure 8–10. Updating the Quartus II Pin Assignments in the Reverse Design Flow

Notes to Figure 8–10:
(1) These are software-specific steps in the design flow and are not necessary for the reverse flow steps of the design.
(2) Refer to Figure 8–1 for the full design flow, which includes the complete I/O Designer software, the DxDesigner 

software, and the board layout tool flowchart details.
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c Both the Quartus II software and the I/O Designer software can export and import an 
FPGA Xchange file. It is therefore possible to overwrite the FPGA Xchange file and 
import incorrect assignments into one or both programs. To prevent this occurrence 
from happening, make a backup copy of the file before importing, and import the 
copy instead of the file generated by the Quartus II software. In addition, assignments 
in the Quartus II software can be protected by following the steps in “Protecting 
Assignments in the Quartus II Software”.

Protecting Assignments in the Quartus II Software
To protect assignments in the Quartus II software, perform the following steps:

1. Start the Quartus II software.

2. On the Assignments menu, click Import Assignments. The Import Assignments 
dialog box appears.

3. Turn on Copy existing assignments into <project name>.qsf.bak before importing 
before importing the FPGA Xchange file. This action automatically creates a 
backup Quartus II constraints file that contains all of your current pin 
assignments.

Generating Symbols for the DxDesigner Software
Along with circuit simulation, circuit board schematic creation is one of the first tasks 
required in the design of a new PCB. Schematics are required to understand how the 
PCB will work, and to generate a netlist that is passed to a board layout tool for board 
design and routing. The I/O Designer software provides the ability to create 
schematic symbols based on the FPGA design exported from the Quartus II software.

Most FPGA devices contain hundreds of pins, requiring large schematic symbols that 
may not fit on a single schematic page. Symbol designs in the I/O Designer software 
can be split or fractured into a number of functional blocks, allowing multiple part 
fractures on the same schematic page or across multiple pages. In the DxDesigner 
software, these part fractures are joined together with the use of the HETERO attribute.

The I/O Designer software can generate symbols for use in a number of Mentor 
Graphics schematic entry tools, and can import changes back-annotated by board 
layout tools to update the database and feed updates back to the Quartus II software 
using the FPGA Xchange file. This section discusses symbol creation specifically for 
the DxDesigner software.

Schematic symbols are created in the I/O Designer software in the following ways:

■ Manually

■ Using the I/O Symbol Wizard

■ Importing previously created symbols from the DxDesigner software

The I/O Designer Symbol Wizard can be used as a design base that allows you to 
quickly create a symbol for manual editing at a later time. If you have already created 
symbols in a DxDesigner project and want to apply a different FPGA design to them, 
you can manually import these symbols from the DxDesigner project. To import the 
symbols, open the I/O Designer software, and on the File menu, click Import 
Symbol.
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f For more information about importing symbols from the DxDesigner software into an 
I/O Designer database, refer to the I/O Designer Help.

Symbols created in the I/O Designer software are either functional, physical (PCB), or 
a combination of functional and physical. A functional symbol is based on signals 
imported into the database, usually from Verilog HDL or VHDL files. No physical 
device pins must be associated with the signals to generate a functional symbol. This 
section focuses on board-level PCB symbols with signals directly mapped to physical 
device pins through assignments in either the Quartus II Pin Planner or in the 
I/O Designer database.

f For information about manually creating symbols, importing symbols, and editing 
symbols in the I/O Designer software, as well as the different types of symbols the 
software can generate, refer to the I/O Designer Help.

Setting Up the I/O Designer Software to Work with the DxDesigner Software
If you created your I/O Designer database using the Database Wizard, you may 
already be set up to export symbols to a DxDesigner project. To verify this, or to 
manually set up the I/O Designer software to work with the DxDesigner software, 
you must set the path to the DxDesigner executable, set the export type to 
DxDesigner, and set the path to a DxDesigner project directory.

To set these options, perform the following steps:

1. Start the I/O Designer software.

2. On the Tools menu, click Preferences. The Preferences dialog box appears.

3. Click Paths, double-click on the DxDesigner executable file path field, and click 
Browse to select the location of the DxDesigner application (Figure 8–11). 

4. Click Apply.

Figure 8–11. Path Preferences Dialog Box
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5. Click Symbol Editor and click Export. In the Export type menu, under General, 
select DxDesigner/PADS-Designer (Figure 8–12).

6. Click Apply and click OK.

7. On the File menu, click Properties. The project Properties dialog box appears.

8. Click the PCB Flow tab and click Path to a DxDesigner project directory.

9. Click OK.

If you did not create a new DxDesigner project in the Database Wizard and you do not 
already have a DxDesigner project, you must create a new database using the 
DxDesigner software, and point the I/O Designer software to this new project.

f For information about creating and working with DxDesigner projects, refer to the 
DxDesigner Help.

Create Symbols with the Symbol Wizard
FPGA symbols based on Altera devices can be created, fractured, and edited using the 
I/O Designer Symbol Wizard. To create a symbol based on a selected Altera FPGA 
device:

1. Start the I/O Designer software.

2. Click Symbol Wizard in the toolbar, or on the Symbol menu, click Symbol 
Wizard. The Symbol Wizard (1 of 6) page is shown (Figure 8–13).

Figure 8–12. Symbol Editor Export Preferences
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3. On the first Symbol Wizard page, in the Symbol name field, enter the symbol 
name. The DEVICE and PKG_TYPE fields are populated with the device and 
package information automatically. Under Symbol type, click PCB. Under Use 
signals, click All.

4. Click Next. The Symbol Wizard (2 of 6) page is shown.

1 If the DEVICE and PKG_TYPE fields are blank or incorrect, cancel the 
Symbol Wizard and select the correct device information. On the File menu, 
click Properties. In the Properties window, click the FPGA Flow tab and 
enter the correct device information.

5. On page 2 of the Symbol Wizard, select fracturing options for your symbol. If you 
are using the Symbol Wizard to edit a previously created fractured symbol, you 
must turn on Reuse existing fractures so that your current fractures are not 
altered. Select other options on this page as appropriate for your symbol.

6. Click Next. The Symbol Wizard (3 of 6) page is shown.

7. Additional fracturing options are available on page 3 of the Symbol Wizard. After 
selecting the desired options, click Next. The Symbol Wizard (4 of 6) page is 
shown.

8. On page 4 of the Symbol Wizard, select the options for how the symbols will look. 
Select the desired options and click Next. The Symbol Wizard (5 of 6) page is 
shown.

9. On page 5 of the Symbol Wizard, define what information will be labeled for the 
entire symbol and for individual pins. Select the desired options and click Next. 
The Symbol Wizard (6 of 6) page is shown.

Figure 8–13. Symbol Wizard
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10. On the final page of the Symbol Wizard, add additional signals and pins that have 
not already been placed in the symbol. Click Finish when you complete your 
selections.

Your symbol is complete. You can view your symbol and any fractures you created 
using the Symbol Editor (Figure 8–14). You can edit parts of the symbol, delete 
fractures, or rerun the Symbol Wizard.

If assignments in the I/O Designer database are updated, the symbols created in the 
I/O Designer software automatically reflect these changes. Assignment changes can 
be made within the I/O Designer software, with an updated FPGA Xchange file from 
the Quartus II software, or from a back-annotated change in your board layout tool.

Export Symbols to the DxDesigner Software
After you have completed your symbols, export the symbols to your DxDesigner 
project. To generate all the fractures of a symbol, on the Generate menu, click All 
Symbols. To generate a symbol for the currently displayed symbol in Symbol Editor, 
click Current Symbol Only. Each symbol in the database is saved as a separate file in 
the /sym directory in your DxDesigner project. The symbols can be instantiated in 
your DxDesigner schematics.

f For more information about working with DxDesigner projects, refer to the 
DxDesigner Help.

Scripting Support
The I/O Designer software features a command line Tcl interpreter. All commands 
issued through the GUI in the I/O Designer software are translated into Tcl 
commands that are run by the tool. You can view the generated Tcl commands and 
run scripts, or enter individual commands in the I/O Designer Console window.

The following section includes commands that perform some of the operations 
described in this chapter.

Figure 8–14. The I/O Designer Symbol Editor
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If you want to change the FPGA Xchange file from which the I/O Designer software 
updates assignments, type the following command at an I/O Designer Tcl prompt:

set_fpga_xchange_file <file name>

After the FPGA Xchange file is specified, use the following command to update the 
I/O Designer database with assignment updates made in the Quartus II software:

update_from_fpga_xchange_file

Use the following command to update the FPGA Xchange file with changes made to 
the assignments in the I/O Designer software for transfer back into the Quartus II 
software:

generate_fpga_xchange_file

If you want to import assignment data from a Pin-Out file created by the Quartus II 
software, use the following command:

set_pin_report_file -quartus_pin <file name>

Run the I/O Designer Symbol Wizard with the following command:

symbolwizard

Set the DxDesigner project directory path where symbols are saved with the following 
command:

set_dx_designer_project -path <path>

f For more information about Tcl scripting and Tcl scripting with the Quartus II 
software, refer to the Tcl Scripting chapter in volume 2 of the Quartus II Handbook. For 
more information about the Tcl scripting capabilities of the I/O Designer software as 
well as a list of all the commands available, refer to the I/O Designer Help.

FPGA-to-Board Integration with the DxDesigner Software
The Mentor Graphics DxDesigner software is a design entry tool for schematic 
capture. You can use it to create flat circuit schematics for all types of PCB design. You 
can also use the DxDesigner software to create hierarchical schematics that facilitate 
design reuse and a team-based design. You can use the DxDesigner software in the 
design flow alone or in conjunction with the I/O Designer software. However, if you 
use the DxDesigner software without the I/O Designer software, the design flow is 
one-way, using only the Pin-Out file generated by the Quartus II software.

Signal and pin assignment changes can be made only in the Quartus II software and 
are reflected in updated symbols in a DxDesigner schematic. You cannot 
back-annotate changes made in a board layout tool or in a DxDesigner symbol to the 
Quartus II software. Figure 8–15 shows the design flow when the I/O Designer 
software is not used.
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f For more information about the DxDesigner software, including usage, support, 
training, and product updates, refer to the Mentor Graphics web page at 
www.mentor.com, or choose Schematic Design Help Topics in the DxDesigner Help.

DxDesigner Project Settings
New projects in the DxDesigner software are already set up to create FPGA symbols 
by default. However, for complete support and compatibility with the I/O Designer 
software, if it is used with the DxDesigner software, you should enable the 
DxBoardLink Flow options.

You can enable the DxBoardLink flow design configuration while creating a new 
DxDesigner project or after a project is created.

To enable the DxBoardLink flow design configuration when creating a new 
DxDesigner project, perform the following steps:

1. Start the DxDesigner software.

2. On the File menu, click New and click the Project tab. The New dialog box 
appears (Figure 8–16).

Figure 8–15. Design Flow Without the I/O Designer Software (Note 1)

Note to Figure 8–15:
(1) Refer to Figure 8–1 for the full design flow, which includes the Quartus II software, the I/O Designer software, and 

the board layout tool flowchart details.
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3. Click More. Turn on DxBoardLink (Figure 8–16).

1 To enable the DxBoardLink Flow design configuration in an existing 
project, click Design Configurations in the Design Configuration toolbar 
and turn on DxBoardLink (Figure 8–17).

DxDesigner Symbol Wizard
In addition to circuit simulation, circuit board schematic creation is one of the first 
tasks required in the design of a new PCB. Schematics are required to understand how 
the PCB will work, and to generate a netlist that is passed on to a board layout tool for 
board stackup design and routing.

Figure 8–16. New Project Dialog Box

Figure 8–17. DxBoardLink Design Configuration
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You can create schematic symbols using the DxDesigner software based on FPGA 
designs exported from the Quartus II software through the Pin-Out file for 
instantiation in DxDesigner schematic design files. Most FPGA devices are physically 
large with hundreds of pins, requiring large schematic symbols that may not fit on a 
single schematic page. You can split or fracture symbols created in the DxDesigner 
software into a number of functional blocks, allowing multiple part fractures on the 
same schematic page or across multiple pages. In the DxDesigner software, these part 
fractures are joined together with the use of the HETERO attribute.

You can create schematic symbols in the DxDesigner software manually or with the 
Symbol Wizard. The DxDesigner Symbol Wizard is similar to the I/O Designer 
Symbol Wizard, but with fewer fracturing options.

FPGA symbols based on Altera devices can be created, fractured, and edited using the 
DxDesigner Symbol Wizard. To start the Symbol Wizard, perform the following steps:

1. Start the DxDesigner software.

2. Click Symbol Wizard in the toolbar, or on the File menu, click New. The New 
window is shown. Click the File tab and create a new file of type Symbol Wizard. 

3. Enter the new symbol name in the name field and click OK. The Symbol Wizard 
page is shown (Figure 8–18).

Figure 8–18. Wizard Task Selection
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4. On the Wizard Task Selection page, choose to create a new symbol or modify an 
existing symbol. If you are modifying an existing symbol, specify the library path 
or alias, and select the existing symbol. If you are creating a new symbol, select 
DxBoardLink for the symbol source. The DxDesigner block type defaults to 
Module because the FPGA design does not have an underlying DxDesigner 
schematic. Define whether or not to fracture the symbol. After making your 
selections, click Next. The New Symbol and Library Name page is shown.

5. On the New Symbol and Library Name page, enter a name for the symbol, an 
overall part name for all of the symbol fractures, and a library name for the new 
library created for this symbol. By default, the part and library names are the same 
as the symbol name. Click Next. The Symbol Parameters page is shown.

6. On the Symbol Parameters page, decide how the generated symbol will look and 
how it will match up with the grid you have set in your DxDesigner project 
schematic. After making your selections, click Next. The DxBoardLink Pin List 
Import page is shown (Figure 8–19).

7. On the DxBoardLink Pin List Import page, in the FPGA vendor list, select Altera 
Quartus. In the Pin-Out file to import field, browse to and select the Pin-Out file 
from your Quartus II design project directory. Additionally, select choices from the 
Fracturing Scheme options, Bus pin options, and Power pin options. After you 
make your selections, click Next. The Symbol Attributes page is shown.

8. On the Symbol Attributes page, select to create or modify symbol attributes for 
use in the DxDesigner software. After you make your selections, click Next. The 
Pin Settings page is shown.

Figure 8–19. DxBoardLink Pin List Import
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9. On the Pin Settings page, make any final adjustments to pin and label location 
and information. Each tabbed spreadsheet represents a fracture of your symbol. 
After you make your selections, click Save Symbol.

After you save the symbol, you can examine and place any fracture of the symbol in 
your schematic. When you are finished with the Symbol Wizard, all the fractures you 
created are saved as separate files in the library you specified or created in the /sym 
directory in your DxDesigner project. You can add the symbols to your schematics or 
you can edit the symbols manually or with the Symbol Wizard.

1 Symbols created in the DxDesigner software can be edited and updated with newer 
versions of the Pin-Out file generated by the Quartus II software. However, symbol 
fracturing is fixed, and the symbol cannot be fractured again. To create new fractures 
for your design, create a new symbol in the Symbol Wizard, and follow the steps in 
“DxDesigner Symbol Wizard” on page 8–25.

f For more information about creating, editing, and instantiating component symbols 
in DxDesigner, choose Schematic Design Help Topics from the Help menu in the 
DxDesigner software.

Conclusion
Transferring a complex, high-pin-count FPGA design to a PCB for prototyping or 
manufacturing is a daunting process that can lead to errors in the PCB netlist or 
design, especially when multiple engineers are working on different parts of the 
project. The design workflow available when the Quartus II software is used in 
conjunction with the Mentor Graphics toolset assists the FPGA designer and the 
board designer in preventing errors and focusing their attention on the design.
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